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Chapter 1. Introduction

The Infoprint Manager Print-on-Demand Feature consists of the following three
clients:

+ IBM® Infoprint® Submit Express for the Windows® Operating System
* IBM Infoprint Submit for the Windows Operating System
* IBM Infoprint Submit for the Macintosh Operating System

Who should read this publication

This document is for the user who installs, configures, and uses Infoprint Submit
on a Macintosh workstation.

Most recent information

This document is available on the appropriate Print-on-Demand Feature CD-ROM.

For the most recent information about Infoprint Manager, go to the IBM Printing
Systems website at http://www.ibm.com/printers and click on Software, click on
pSeries (AIX) or xSeries (Windows or OS/2), scroll down to the appropriate
Infoprint Manager, and click on Learn more.

The Infoprint publication library

For the most current information, see the IBM Printing Systems website at
http://www.ibm.com/printers.

Infoprint Manager common publication library

These publications are common to both Infoprint Manager for AlIX and Infoprint
Manager for Windows:

* IBM Infoprint Manager: Update Guide for PTF U483536 and PTF UR54088,
S544-5895. This publication contains information describing fixes and product
enhancements available with these service updates for both Infoprint Manager
for AIX Version 4 Release 1 and Infoprint Manager for Windows Version 2
Release 1. These service updates become available to customers in December
2003. Earlier versions of some of this information have been published
previously in the current product library.

* Infoprint Manager: SAP R/3 Planning and Configuration Guide, S544-5902. For print
administrators who need to create and configure both the SAP R/3 environment.
IBM recommends that users possess a detailed knowledge of a SAP R/3
environment, as well as administering and maintaining either AIX or Windows
operating systems. This publication describes how a business enterprise that
uses SAP R/3 can use either Infoprint Manager for AIX or Infoprint Manager for
Windows to manage its print environment.

* IBM Infoprint Manager: Reference, S544-5475. For print administrators, operators,
and application programmers with the need to perform command-line functions.
This publication describes the commands, utilities, transforms, attributes, and
attribute values associated with Infoprint.

© Copyright IBM Corp. 2002, 2004 1
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Infoprint Manager for AIX publication library

Infoprint Manager for AIX includes publications in PDF format on a CD-ROM
supplied with the product. You can download PDF versions of these publications
or order printed copies of these publications from IBM at the following website:

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi?CTY=US

Notes:
1. There is a fee for the printed manuals.
2. You can use the form number specified for a publication to download a PDF

version or order a printed version.

The publications for Infoprint Manager for AlX are:

IBM Infoprint Manager for AIX: Installation Instructions, G544-5891. This
publication provides updated migration and installation information from the
instructions available in the IBM Infoprint Manager for AIX: Getting Started
manual.

IBM Infoprint Manager for AIX: Introduction and Planning Guide, G544-5833. This
publication gives an overview of Infoprint Manager for AlX, introduces its
concepts, and helps you prepare to use it. It addresses migration from previous
versions of the product. Finally, this publication explains the differences between
the AIX and Windows versions of Infoprint.

IBM Infoprint Manager for AIX: Getting Started, G544-5817. This publication helps
you install and configure IBM Infoprint Manager for AIX. It focuses primarily on
server and client system software configuration.

Guidelines for Installing Infoprint Manager for AIX 4.1 in an HACMP Configuration,
G544-5818. This publication helps you install and configure HACMP with IBM
Infoprint Manager for AIX. It also tells you how to use HACMP with IBM
Infoprint Manager for AlX.

IBM Infoprint Manager for AIX: Configuring and Using Infoprint Fax, G544-5915.
This publication describes the primary tasks necessary for installing, configuring,
and using the Infoprint Fax feature to both send and receive faxes from an
Infoprint Manager for AlX server.

IBM Infoprint Manager for AIX: Impositioning Assist, G544-5910. This publication
describes how commercial print shops can use Infoprint Manager for AlX to
make frequent layout changes to signature-based documents with relatively
static content. As a prerequisite, this solution requires the Infoprint Manager for
AIX Print-On-Demand feature, an IBM Infoprint 4100 Advanced Function
Printing System, and a third-party impositioning product, such as ScenicSoft
Preps.

IBM Infoprint Manager for AIX: Procedures, G544-5815. This publication describes
the primary tasks necessary for setting up an Infoprint environment, submitting
print jobs, scheduling jobs, and managing the print environment.

PSF Direct Network Configuration Guide for System/370, S544-5486. For system
administrators or network specialists responsible for configuring a system for
Print Services Facility (PSF) Direct. PSF Direct is a function of IBM Infoprint
Manager for AlX that allows a PSF program (PSF for z/OS, PSF/390, PSF/400,
PSF/MVS, PSF/VM, or PSF/VSE) to print remotely, using the SNA LU 6.2
protocol, on printers supported by Infoprint. The PSF program sends the print
data stream directly to the Infoprint printer.

IBM PSF for AIX: AFP Upload Configuration Guide Using SNA Server/6000,
S544-5422. For system administrators, this publication describes how to
configure AFP Upload on both AIX (client) and MVS (server) to send files to the
JES spool on the MVS server, using a SNA LU 6.2 protocol.

Submit for Macintosh User’s Guide



IBM PSF for AIX: AFP Upload Configuration Guide Using TCP/IP, S544-5423. For
system administrators, this publication describes how to configure AFP Upload
on both AIX (client) and MVS (server) to send files to the JES spool on the MVS
server, using a TCP/IP protocol.

Infoprint Manager for Windows publication library
Infoprint Manager for Windows includes publications in PDF format on a
CD-ROM supplied with the product. You can download PDF versions of these
publications or order printed copies of these publications from IBM at the
following website:

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi?CTY=US

Notes:
1. There is a fee for the printed manuals.
2. You can use the form number specified for a publication to download a PDF

version or order a printed version.

The publications for Infoprint Manager for Windows are:

IBM Infoprint Manager for Windows: Introduction and Planning Guide, G544-5716.
This publication gives an overview of Infoprint Manager for Windows,
introduces its concepts, and helps you prepare to use it. It describes features of
this product and compares its functions to those of IBM Print Services Facility
for OS/2 (PSF for OS/2). It addresses migration from PSF for OS/2 at a high
level. Finally, this publication explains the differences between the AIX and
Windows versions of Infoprint.

IBM Infoprint Manager for Windows: Getting Started, G544-5717. This publication
helps you install and configure Infoprint Manager for Windows. It focuses
primarily on server and client system software configuration, but it also includes
information for the IBM 4159 Model 001 S/390 Parallel Channel Emulator Card.
IBM Infoprint Manager for Windows: Procedures, G544-5814. This publication
contains all the Infoprint Manager for Windows procedures.

The following publications for Infoprint Manager for Windows do not have a form
number and must be obtained from the Web at www.ibm.com/printers/ipmwinlib:

Infoprint Manager for Windows NT and Windows 2000: Configuring PSF Direct for an
iSeries System . This publication describes how Print Services Facility (PSF Direct)
can be configured on Systems Network Architecture (SNA) networks in an
iSeries operating system.

Infoprint Manager for Windows NT and Windows 2000: Configuring PSF Direct for
the 3174 Communications Controller. This publication describes how Print Services
Facility (PSF Direct) can be configured on Systems Network Architecture (SNA)
networks in a 3174 Token-Ring gateway configuration.

Infoprint Manager for Windows NT and Windows 2000: Configuring PSF Direct for
the 3172 Communications Controller. This publication describes how Print Services
Facility (PSF Direct) can be configured on Systems Network Architecture (SNA)
networks in a 3172 Token-Ring gateway configuration.

Infoprint Manager for Windows NT and Windows 2000: Configuring PSF Direct for
the 37xx Communications Controller. This publication describes how Print Services
Facility (PSF Direct) can be configured on Systems Network Architecture (SNA)
networks in either a local 37xx Token-Ring gateway configuration or remote
37xx Token-Ring gateway configuration.

Chapter 1. Introduction 3
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Chapter 2. Setting up Infoprint Submit on a Macintosh system

Macintosh Requirements

Infoprint Submit has these minimum requirements:

PowerMac

Macintosh running OS X version10.1 or later

32 MB RAM

5 MB hard drive space

Local area network (LAN) connection (Ethernet)

Network connectivity with a user ID having permission to submit print jobs and
perform queries

Installing Infoprint Submit

This section contains information that you need to install Infoprint Submit.

1.

5.
6.

Insert the Infoprint Manager Print-on-Demand Feature CD-ROM (2 of 2) into
the drive and double-click its icon on the desktop.

Specify the directory where you want the install program to be unpacked.

Double-click the install file icon for your language to uncompress the install
program, for example, Submitinstaller_en_US.hqgx.

Double-click the install program icon (for example, Submitinstaller_en_US) to
start installing the program.

Specify the directory where you want the program to be installed.
Follow the instructions as directed from the installer.

It is recommended that you install Submit in the Applications directory of the
Hard Drive. Once the product is installed, you can create an alias on the desktop
to provide easy access to Submit. To do this, highlight the Infoprint Submit file,
then choose Make alias from the File menu, and drag the alias onto the desktop.

Starting Infoprint Submit

After installing Infoprint Submit and associated software, you can access the
programs by clicking on the Infoprint Submit icon.

1.
2.

© Copyright IBM Corp. 2002, 2004

Go to the Options menu, and select Settings. The Settings dialog displays.
Select the Connections tab.
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(S) Settings

. }
l Connections { Preferences

Server IP address aixipm

Port 6874

E OK * ’J_I:'_‘ancel x ’J Help

Figure 1. The Settings Dialog Connections Tab.

3. Enter the IP address for your Infoprint Manager Server.
4. Let the port number default.
5. Select the Preferences tab.

[ &

(&) Settings

[ ,
Connections } Preferences*'l

Decimal notation

) Use . as delimiter
_ Use, as delimiter

Units
@ Millimeters
__ Inches

(’ oK~ / Cancel \ / Help

Figure 2. The Settings Dialog Preferences Tab.

6. Select your preferences for Decimal notation and Units of measure.
7. Click OK to return to the main Infoprint Submit screen.

Submit for Macintosh User’s Guide



Chapter 3. Using Infoprint Submit to process a job

IBM Infoprint Submit is used through the life cycle of a job. A print shop uses
Infoprint Submit on a Macintosh system to create a job ticket for the job, submit
the job to the Infoprint Manager server for printing, and track the job.

Job tickets

An Infoprint job consists of a job ticket and all the files associated with that job. A
job ticket contains all the specifications for a job. The job ticket refers to the
customer’s job data and resources and pulls them together in a job bundle. You can
create a job ticket by using Infoprint Submit.

You can print any part of the data by submitting a print job.

Migrating job tickets from previous versions of Infoprint Submit

© Copyright IBM Corp. 2002, 2004

To migrate job tickets from a previous version of Submit to your current version of
Submit on Mac OS Version 10.1, do the following:

1. From the previous version of Submit, open the job ticket you want to migrate.
2. Submit the job:
* Open the Ticket menu and select Submit Job to submit the job.
» Select the Schedule tab from the Submit dialog.
» Select Hold from the RIP options group box.
* Click OK to submit the job.
3. Select Options — Job Status to open the Job Status dialog.
4. Do the following to copy the contents of the job ticket file to a text file:
» Select the ticket you want to migrate.
* Click the View Ticket button to open the Job Ticket window.
» Highlight the entire contents of the job ticket file.
» Copy the contents of the job ticket file to the clipboard (press Command+C).
* Open a new file in a text editor.
» Paste the job ticket file contents into this new file (press Command+V).
» Save the file. (Be sure this file has an extension of .jtk.)

5. Transfer all source files listed in your job ticket file, and the converted job ticket
file, to the system that has the current version of Submit. Save them in the
directory where the Infoprint Submit files have been saved or where they can
be easily located.

6. In your current version of Submit, select Ticket —+Open to open the migrated
job ticket file. An error may occur the first time you assign a source file to the
migrated job ticket if the path to the file has changed. Use the Browse function
to locate the file, and Submit will save the new location information.



Working with print jobs
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When using Infoprint Submit to create the job ticket, you will identify and
organize the printable files and other resources that make up the job. Processing a
job ticket includes these steps:

1. Creating a new job ticket.
2. Adding files, sheets, and documents to the job ticket.

3. Selecting the layout of the job, the desired server and printer, and other
attributes of the job.

4. Submitting the job and setting print options, such as saving the RIP file or
holding the job at the printer.

5. Tracking the job by displaying messages.

Creating files for printing

You generate the printable files that you submit to Infoprint Manager, file by file,
from the application that you use for authoring. You can use the Adobe PostScript
driver and IBM Infoprint PostScript Printer Description files (PPDs) to convert files
to PostScript. You can use Infoprint Scan to create printable files from hardcopy.

Note: Infoprint Scan is a PRPQ (5799-GTG).

Creating a job ticket

Once you have installed the Infoprint Submit application on your Macintosh
system, you can begin creating job tickets that support the orders you receive from
customers.

Describing your job

Using an Infoprint Submit Job Ticket window, you can describe your job. The
description can include a job name, an ID, a specific description of the job, the
customer name, and other information that will assist you as you refer to the job
ticket.

[Figure 3 on page 9 shows an Infoprint Submit job ticket.

Submit for Macintosh User’s Guide
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Figure 3. An example of an Infoprint Submit job ticket

To begin working on a new ticket, you start Infoprint Submit. The Job Ticket
window displays.

As you create the job ticket, use the Help menu from the Job Ticket window or the
Help button on the dialogs to guide you.

You can create a new job ticket using the Ticket — New option on the Menu bar,
or you can open a previously created job ticket using the Ticket — Open option
on the Menu bar. You can use the Ticket — Submit option on the Menu bar and
then use the Files tab to print the entire job or any of the items or files listed in the
job ticket. If you want to print just the ticket itself, open the job ticket using a text
editor and then select Print.

|Figure 4 on page 10| shows the Ticket menu, which contains general tasks that you
can perform as you work with job tickets.

Chapter 3. Using Infoprint Submit to process a job 9
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Save As... |
Submit Job... ~P &

Figure 4. Infoprint Submit job ticket menu

Specifying how you want the job to print

You can describe the layout of your document and specify alignment values. You

can adjust characteristics such as the front to back alignment of your document. If
the image is smaller than the page, you use this window to adjust the position of
the image on the page.

[Figure 5 on page 11| shows the Adjust Page Placement window.
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Figure 5. The Adjust Page Placement window

Working with files in a job ticket

You build job tickets by adding items in the correct order that refer to the files that
you are printing. The files you print may be printable text files or graphic files.
Graphic files may include printable files that were created from hard copy by
using Infoprint Scan. Files may reside on your hard disk or in a shared directory
on another system.

Submitting a print job

When you select Submit Job from the Ticket menu, you can indicate which files to
print and how to schedule and process your job.

From the Files tab, you can choose the printer from a list of printers on your
servers. You can specify what files to print and how many copies to print.

Chapter 3. Using Infoprint Submit to process ajob 11
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Figure 6. The Files tab for job submission

Figure 6[shows the Files tab that displays when you choose to submit a job. In this
case, a data item has been selected for printing on a logical printer named
np24-ad-1d.

[Figure 7 on page 13| shows the Schedule tab, where you indicate when and how
you want your job to be processed. Because the time it takes to print a job includes
both the processing (RIPing) and the actual printing, you may want to control
these activities separately to optimize the flow of paper through your printers. You
may want your job to be held in the print queue before being RIPed and printed.
You may want to RIP it now, but print it later. You can specify how long you
would like your job to be retained on the server so that it can be printed again.

12  submit for Macintosh User’s Guide
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Figure 7. The Schedule tab for job submission

If you select Print in the RIP Options box on the Schedule tab, the job will be
added to the print queue and will RIP and print automatically. An operator will
not have to release the job.

Saving the RIP output

The raster image processor (RIP) file is generated during the print process. Because
PostScript to RIP processing can be costly, you may want to save your RIP files for
re-printing jobs to avoid having to RIP them again.

When you add a file to your job ticket, click the Save RIPed files check box option
on the Print tab to specify that the RIPed file is to be saved. The RIP file is saved
in the /var/pd/<servername> directory.

Note: If you save your RIPed files, you must manually remove them from the
server.

Verifying that PostScript jobs are ready to print

If your Infoprint server receives a PostScript job from a personal computer system,
you must ensure that the Type 1 fonts required to print are either:

» Contained within the job (inline)

* Available on the server

If the fonts are contained inline, you should have no problem in printing the
output. However, if the fonts are not available on the server, by default a job will
be cancelled.

Chapter 3. Using Infoprint Submit to process a job 13
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Restrictions in the Mac operating system or Java implementation tools have caused

the following known product limitations in this version of Infoprint Submit:

* When using File — Save As, or if the user is saving a job ticket for the first
time, the Name field is not displayed as the default file name for saving the
ticket.

» After recovering from a System Standby, the spin buttons (up/down arrow
buttons) on entry fields cannot be used with the mouse. You can type a value
into the entry fields, or use the arrow keys on the keyboard to change the
displayed values.

* When migrating job tickets for which duplex printing and a separate back side
adjustment are selected, page placement values for the back side of the paper
are not saved in the migrated job ticket. Settings for the back side must be
adjusted manually.

* Some keyboard usage methods do not conform to standard system controls.
Refer to the online Help for Infoprint Submit for instructions on using the
keyboard.

Submit for Macintosh User’s Guide



Chapter 4. Using Infoprint Submit to send jobs to a
continuous forms printer

This topic applies to all Infoprint continuous forms printers, such as the Infoprint
4000 and the Infoprint Color 130 Plus. It assumes that you have already created a
PSF actual destination to represent a continuous forms printer and printed a test
job. It further assumes that you have installed Infoprint Submit, and are at least
somewhat familiar with how to use it.

Many of these procedures use the Infoprint Manager Administration GUI. If you
need additional information or assistance with the GUI, refer to the online help
system.

General configuration information

There are some settings on the Infoprint Manager server that you can consider
setting based on your print environment.

* If you will be printing multiple copies of your print jobs, set the Optimize for
Copies option on the actual destination.

1. In the Infoprint Manager Administration GUI, select the actual destination
that represents the printer.

2. Select Printer —» Change Tuning.

Note: If Change Tuning doesn’t appear on the printer menu, use
Add/Remove menu items to add it.

3. Change Optimize for Copies to yes.

Note: The default value for Optimize for Copies is yes for actual
destinations representing Infoprint 4000 and Infoprint 4100 printer
devices that are migrated from PSF for AIX or created using the basic
Infoprint administrator’s GUI available with the Infoprint Manager’s
Print-On-Demand Feature.

» If you are printing to an Infoprint Color 130 Plus and you print mostly small
jobs, increase the Maximum concurrent jobs value for the actual destination to
10. That way, up to ten jobs can be processing at the same time, which reduces
lag time between jobs and helps to eliminate clutching.

1. In the Infoprint Manager Administration GUI, select the actual destination
that represents the printer.

2. Select Printer —» Change Tuning.

Note: If Change Tuning doesn’t appear on the printer menu, use
Add/Remove menu items to add it.

3. Change Maximum concurrent jobs to 10.

Configuring media
Preparation
Before you configure any media, make a list of all of the different layout types that

jobs will use. In the list, include the page lengths, n-up specifications, job

© Copyright IBM Corp. 2002, 2004 15
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orientation (portrait or landscape), and any other information that you have. Give
each type of job a name. You will use this hame on the printer and in Infoprint
Manager. Images of some common layout types, along with their specifications, are
provided below to help you create your list.

Simple 1-up, with finished page size ledger
In this layout, the AFCCU form is wider than it is long. Even if you specify a

value for Page placement (X and Y shift) in Infoprint Submit, the form definition
will override it.

Ledger

»
>»

Web direction

Figure 8. Ledger-sized document printed 1-up, landscape orientation

Table 1. Infoprint Manager and Infoprint Submit values for Ledger-sized document printed
1-up, landscape

Option Value
Finished page (document) size 17 x 11 inches
Form size (Untrimmed page size: width and |17 x 11 inches
length)

Media size (in Infoprint Manager) 17 x 11 inches
Layout Simple 1-up
Form definition F100LAND
PDF orientation Landscape
Postscript orientation Landscape

Submit for Macintosh User’s Guide



Simple 1-up, with finished page size poster

In this layout, the AFCCU form size is longer than it is wide. If the finished
document size is smaller than 17 x 25 inches (for example, 16 x 24 inches), you
should make the finished page size equal to the document size.

Poster

Web direction

Figure 9. Poster-sized document printed 1-up, portrait orientation

Table 2. Infoprint Manager and Infoprint Submit values for 17 x 25 inch document printed
1-up, portrait

Option Value

Finished page (document) size 17 x 25 inches

Form size (Untrimmed page size: width and |17 x 25 inches or larger
length)

Media size (in Infoprint Manager) 17 x 25 inches or larger
Layout Simple 1-up

Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 2—-up, with finished page size letter

In this layout, the AFCCU form is wider than it is long. Because you don’t specify
a form definition, you can use the Page placement (X and Y shift) option in
Infoprint Submit.

Chapter 4. Using Infoprint Submit to send jobs to a continuous forms printer 17



Letter

»
>

Web direction

Figure 10. Letter-sized document printed 2—up, portrait orientation

Table 3. Infoprint Manager and Infoprint Submit values for letter-sized document printed
2—-up, portrait

Option Value

Finished page (document) size 8.5 x 11 inches

Form size (Untrimmed page size: width and |17 x 11 inches or larger
length)

Media size (in Infoprint Manager) 17 x 11 inches or larger
Layout Side by side copies 2-up
Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 2—-up, with finished page size legal
In this layout, the AFCCU form is wider than it is long. Because you don’t specify

a form definition, you can use the Page placement (X and Y shift) option in
Infoprint Submit.

Note: This layout looks the same as the layout for side-by-side copies 2—up with
finished page size letter. Refer to [Figure 9 on page 17| for an illustration of the
layout.
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Table 4. Infoprint Manager and Infoprint Submit values for legal-sized document printed
2—-up, portrait

Option Value

Finished page (document) size 8.5 x 14 inches

Form size (Untrimmed page size: width and |17 x 14 inches or larger
length)

Media size (in Infoprint Manager) 17 x 14 inches or larger
Layout Side-by-side copies 2-up
Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 2—-up, with finished page size 9 x 8 inches

In this layout, the AFCCU form size is wider than it is long. Because you don’t
specify a form definition, you can use the Page placement (X and Y shift) option in
Infoprint Submit.

9x8

-
>»>

Web direction

Figure 11. Nine by eight inch document printed 2—up, landscape orientation

Table 5. Infoprint Manager and Infoprint Submit values for 9 x 8 inch document printed
2—-up, landscape

Option Value

Finished page (document) size 9 x 8 inches
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Table 5. Infoprint Manager and Infoprint Submit values for 9 x 8 inch document printed
2—-up, landscape (continued)

Option Value

Form size (Untrimmed page size: width and |18 x 8 inches or larger
length)

Media size (in Infoprint Manager) 18 x 8 inches or larger
Layout side-by-side copies 2-up
Form definition blank

PDF orientation Landscape

Postscript orientation Landscape

Side-by-side copies 2—-up, with finished page size double-high
letter

In this layout, the AFCCU form is longer than it is wide. Because you don’t specify
a form definition, you can use the Page placement (X and Y shift) option in
Infoprint Submit.

Doubble high Letter

Web direction

Figure 12. Double—high letter document printed 2—up, portrait orientation

Table 6. Infoprint Manager and Infoprint Submit values for double—high letter-sized
document printed 2—up, portrait

Option Value

Finished page (document) size 8.5 x 22 inches
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Table 6. Infoprint Manager and Infoprint Submit values for double—high letter-sized

document printed 2—up, portrait (continued)

Option

Value

Form size (Untrimmed page size: width and
length)

17 x 22 inches or larger

Media size (in Infoprint Manager)

17 x 22 inches or larger

Layout side-by-side copies 2-up
Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 3-up, finished page size 6 x 11 inches
In this layout, the AFCCU form is wider than it is long. Because you don’t specify
a form definition, you can use the Page placement (X and Y shift) option in

Infoprint Submit.

6 x 11

Web direction

Figure 13. Six by eleven inch document printed 3—up, portrait orientation

Table 7. Infoprint Manager and Infoprint Submit values for 6 x 11 inch document printed

3—up, portrait

Option

Value

Finished page (document) size

6 x 11 inches

Form size (Untrimmed page size: width and
length)

18 x 11 inches or larger

Chapter 4. Using Infoprint Submit to send jobs to a continuous forms printer
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Table 7. Infoprint Manager and Infoprint Submit values for 6 x 11 inch document printed
3—up, portrait (continued)

Option Value

Media size (in Infoprint Manager) 18 x 11 inches or larger
Layout Side-by-side copies 3-up
Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 3—-up, with finished page size double-high

In this layout, the AFCCU form is longer than it is wide. Because you don’t specify
a form definition, you can use the Page placement (X and Y shift) option in
Infoprint Submit.

6 X22

Web direction

Figure 14. Six by twenty—two inch document printed 3—up, portrait orientation

Table 8. Infoprint Manager and Infoprint Submit values for double-high document printed
3—up, portrait

Option Value

Finished page (document) size 6 x 22 inches

Form size (Untrimmed page size: width and |18 x 22 inches or larger
length)

Media size (in Infoprint Manager) 18 x 22 inches or larger
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Table 8. Infoprint Manager and Infoprint Submit values for double-high document printed

3—up, portrait (continued)

Option Value

Layout Side-by-side copies 3-up
Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 4—-up, with finished paper size 9 x 6 inches

In this layout, the AFCCU form is wider than it is long. Because you don’t specify
a form definition, you can use the Page placement (X and Y shift) option in

Infoprint Submit.

9x6

Web direction

Figure 15. Nine by six inch document printed 4—up, landscape orientation

Table 9. Infoprint Manager and Infoprint Submit values for 9 x 6 inch document printed

4—up, landscape

Option

Value

Finished page (document) size

9 x 6 inches

Form size (Untrimmed page size: width and
length)

18 x 12 inches or larger

Media size (in Infoprint Manager)

18 x 12 inches or larger

Layout

side-by-side copies 4-up

Chapter 4. Using Infoprint Submit to send jobs to a continuous forms printer
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Table 9. Infoprint Manager and Infoprint Submit values for 9 x 6 inch document printed
4—up, landscape (continued)

Option Value
Form definition blank
PDF orientation Landscape
Postscript orientation Landscape

Side-by-side copies 4—-up, with finished paper size letter

In this layout, the AFCCU form is longer than it is wide. Because you don’t specify
a form definition, you can use the Page placement (X and Y shift) option in
Infoprint Submit.

Letter

Web direction

Figure 16. Letter—sized document printed 4—up, portrait orientation

Table 10. Infoprint Manager and Infoprint Submit values for letter-sized document printed

4-up

Option Value

Finished page (document) size 8.5 x 11 inches

Form size (Untrimmed page size: width and |17 x 22 inches or larger
length)

Media size (in Infoprint Manager) 17 x 22 inches or larger
Layout side-by-side copies 4-up
Form definition blank
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Table 10. Infoprint Manager and Infoprint Submit values for letter-sized document printed

4—up (continued)

Option Value
PDF orientation Landscape
Postscript orientation Landscape

On the printer

Define snapshots on the printer for each type of job that you identified. Use the
names that you created above. If your list does not include dimensions, add them

as you create each snapshot.

Note: All Infoprint continuous forms printers round form lengths to the nearest
1/6 inch. Therefore, it is recommended that you use lengths in increments of

1/6 inch. Use|[Table 11|as a guide.

Table 11. Decimal equivalents of common fractions

Fraction of an inch Decimal equivalent
1/6 0.167

2/6 =1/3 0.333

3/6=1/2 0.5

4/6 = 2/3 0.667

5/6 0.833

In Infoprint Manager
1. Open the Infoprint Manager Administration GUI.

2. Verify that all of the menu items and details views columns that you will need
are displayed.

a. Select Options — Customize.
b. On the Printer tab, make sure the Change media check box is selected in

the Menu column and that Media ready is listed in the Details to show
box.

c. On the Job tab, make sure that the Change media and Change copies check
boxes are selected in the Menu column. Make sure that Media is listed in
the Details to show box.

3. Define the new media.
a. Select Server — Media — Create.

b. In the Create Media dialog, fill in the Name, Server, and Untrimmed width
and length (inches) fields as specified below. You can fill in the other fields
if you like, but these three are the only required fields. Refer to the online
help for additional information about the other fields.

Name One of the media types from your list.

Server The name of the Infoprint Manager server that sends jobs to your
printer.

Untrimmed width and length (inches)
Specify width and length values that are slightly shorter than the
ones you gave in the snapshot on the printer. The PostScript
transform and some printers (such as the Infoprint 4000) round off
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4.

some values, so setting the width and length to slightly shorter
values accommodates that rounding. The values should be at least
.02 inches (1 mm) less than the values in the corresponding
snapshot.

c. Click OK.

d. Repeat step for the rest of the media types you need to define.
Set the Media allowed values for the printer.

a. Select the actual destination in the tree view of the GUI

Select Printer — Change media.

In the Change Media dialog, click the Media Allowed tab.

Add the new media types that you just defined to the Values list.

e. Remove any types that shouldn’t be allowed from the Values list.

f. Click OK.

Decide if you want to have more than one media type ready on the printer at
the same time. If you only have one type ready, only jobs that request that
media will be printed. Other jobs will wait in the queue until you change the
media type that is ready. Once you have decided, set the Media ready value to
the type or types that you want to print on.

a. Select the actual destination in the tree view of the GUI

b. Select Printer —»Change media.

c. On the Media Ready tab, type 1 for the Input bin number, then select the
Media type and Input tray for each media that you want to make ready.

d. Click OK.

a oo

Using Infoprint Submit to send jobs

1.

o

10.

Open Infoprint Submit and build a job ticket as usual.

2. Select Options — Refresh to update the list of media types from the server.
3.
4. Select the appropriate Printer type from the drop-down list, then select the

After all of the documents have been added, click the Print tab.

media type that you want to use from the Paper drop-down list.

Click the Layout tab.

Select the appropriate page layout (for example, side by side copies 2-up or
simple 3-up) from the Layout drop-down.

Click the Align tab.

Set the dimensions in the Finished page size box to the exact dimensions of
the pages in the job.

Note: You can set these dimensions in either inches or millimeters. Use
Options — Preferences to change the unit of measure.

The values in the Untrimmed page size box map to the partition area within

the printer’s printable area.

By default, the page placement (X and Y offset) value is Upper left, so the
document will be placed in the upper left corner of the form. If you want the
document to be positioned differently, select a different page placement value.

Submit the job as usual.

Troubleshooting

If you submit a job that requests a media type that isn’t listed as ready in the
server, the job icon will turn red. To print the job, do the following:
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1. Change the snapshot on the printer.

2. In the Infoprint Manager GUI, highlight the printer, then select Printer —
Change Media.

3. On the Media Ready tab of the Change Media dialog, change the values to the
media you want to use.

4. Click OK.

Once the Media Ready value is reset, jobs that request the changed media type
will start to print.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property rights may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) described in this publication at any time without
notice.

Any references in this information to non-1IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

© Copyright IBM Corp. 2002, 2004 29



30

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

Department 11PA Building 002S
PO Box 1900

Boulder CO 80301 USA

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee. The licensed program described in this
document and all licensed material available for it are provided by IBM under
terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM'’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

For online versions of this book, we authorize you to:

» Copy, modify, and print the documentation contained on the media, for use
within your enterprise, provided you reproduce the copyright notice, all
warning statements, and other required statements on each copy or partial copy.

» Transfer the original unaltered copy of the documentation when you transfer the
related IBM product (which may be either machines you own, or programs, if
the program’s license terms permit a transfer). You must, at the same time,
destroy all other copies of the documentation.

You are responsible for payment of any taxes, including personal property taxes,
resulting from this authorization.

Your failure to comply with the terms above terminates this authorization. Upon
termination, you must destroy your machine readable documentation.
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Trademarks

The following are trademarks or registered trademarks of International Business
Machines Corporation:

Advanced Function Printing
AFP

AIX

AS/400

eNetwork

IBM

IBM Cross Platform Technologies for Windows
Infoprint

Intelligent Printer Data Stream
IPDS

Micro Channel

MVS

0S/2

0S/390

0S/400

Print Services Facility

S/390

System/370

The following are trademarks of other companies:

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or
both.

Microsoft, MS-DOS, Windows, Windows NT, Windows 2000, Windows ME,
Microsoft Visual Basic, Microsoft Visual C++, and the Windows logo are
trademarks of Microsoft Corporation in the United States, other countries, or
both.

Pentium is a registered trademark of Intel Corporation in the United States,
other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and
other countries.

Other company, product, and service names may be trademarks or service marks
of others.
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Printing Systems Division
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